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申し上げます。 

 

ルネサスエレクトロニクス ホームページ（http://www.renesas.com） 

 

 

 

 

2010 年 4 月 1 日 

ルネサスエレクトロニクス株式会社 

 

 

 

 

 

【発行】ルネサスエレクトロニクス株式会社（http://www.renesas.com） 

【問い合わせ先】http://japan.renesas.com/inquiry 

 



ご注意書き 

 

１． 本資料に記載されている内容は本資料発行時点のものであり、予告なく変更することがあります。当社製品

のご購入およびご使用にあたりましては、事前に当社営業窓口で最新の情報をご確認いただきますとともに、

当社ホームページなどを通じて公開される情報に常にご注意ください。 
2. 本資料に記載された当社製品および技術情報の使用に関連し発生した第三者の特許権、著作権その他の知的

財産権の侵害等に関し、当社は、一切その責任を負いません。当社は、本資料に基づき当社または第三者の

特許権、著作権その他の知的財産権を何ら許諾するものではありません。 
3. 当社製品を改造、改変、複製等しないでください。 
4. 本資料に記載された回路、ソフトウェアおよびこれらに関連する情報は、半導体製品の動作例、応用例を説

明するものです。お客様の機器の設計において、回路、ソフトウェアおよびこれらに関連する情報を使用す

る場合には、お客様の責任において行ってください。これらの使用に起因しお客様または第三者に生じた損

害に関し、当社は、一切その責任を負いません。 
5. 輸出に際しては、「外国為替及び外国貿易法」その他輸出関連法令を遵守し、かかる法令の定めるところに

より必要な手続を行ってください。本資料に記載されている当社製品および技術を大量破壊兵器の開発等の

目的、軍事利用の目的その他軍事用途の目的で使用しないでください。また、当社製品および技術を国内外

の法令および規則により製造・使用・販売を禁止されている機器に使用することができません。 
6. 本資料に記載されている情報は、正確を期すため慎重に作成したものですが、誤りがないことを保証するも

のではありません。万一、本資料に記載されている情報の誤りに起因する損害がお客様に生じた場合におい

ても、当社は、一切その責任を負いません。 
7. 当社は、当社製品の品質水準を「標準水準」、「高品質水準」および「特定水準」に分類しております。また、

各品質水準は、以下に示す用途に製品が使われることを意図しておりますので、当社製品の品質水準をご確

認ください。お客様は、当社の文書による事前の承諾を得ることなく、「特定水準」に分類された用途に当

社製品を使用することができません。また、お客様は、当社の文書による事前の承諾を得ることなく、意図

されていない用途に当社製品を使用することができません。当社の文書による事前の承諾を得ることなく、

「特定水準」に分類された用途または意図されていない用途に当社製品を使用したことによりお客様または

第三者に生じた損害等に関し、当社は、一切その責任を負いません。なお、当社製品のデータ・シート、デ

ータ・ブック等の資料で特に品質水準の表示がない場合は、標準水準製品であることを表します。 
標準水準： コンピュータ、OA 機器、通信機器、計測機器、AV 機器、家電、工作機械、パーソナル機器、

産業用ロボット 
高品質水準： 輸送機器（自動車、電車、船舶等）、交通用信号機器、防災・防犯装置、各種安全装置、生命

維持を目的として設計されていない医療機器（厚生労働省定義の管理医療機器に相当） 
特定水準： 航空機器、航空宇宙機器、海底中継機器、原子力制御システム、生命維持のための医療機器（生

命維持装置、人体に埋め込み使用するもの、治療行為（患部切り出し等）を行うもの、その他

直接人命に影響を与えるもの）（厚生労働省定義の高度管理医療機器に相当）またはシステム

等 
8. 本資料に記載された当社製品のご使用につき、特に、最大定格、動作電源電圧範囲、放熱特性、実装条件そ

の他諸条件につきましては、当社保証範囲内でご使用ください。当社保証範囲を超えて当社製品をご使用さ

れた場合の故障および事故につきましては、当社は、一切その責任を負いません。 
9. 当社は、当社製品の品質および信頼性の向上に努めておりますが、半導体製品はある確率で故障が発生した

り、使用条件によっては誤動作したりする場合があります。また、当社製品は耐放射線設計については行っ

ておりません。当社製品の故障または誤動作が生じた場合も、人身事故、火災事故、社会的損害などを生じ

させないようお客様の責任において冗長設計、延焼対策設計、誤動作防止設計等の安全設計およびエージン

グ処理等、機器またはシステムとしての出荷保証をお願いいたします。特に、マイコンソフトウェアは、単

独での検証は困難なため、お客様が製造された最終の機器・システムとしての安全検証をお願いいたします。 
10. 当社製品の環境適合性等、詳細につきましては製品個別に必ず当社営業窓口までお問合せください。ご使用

に際しては、特定の物質の含有･使用を規制する RoHS 指令等、適用される環境関連法令を十分調査のうえ、

かかる法令に適合するようご使用ください。お客様がかかる法令を遵守しないことにより生じた損害に関し

て、当社は、一切その責任を負いません。 
11. 本資料の全部または一部を当社の文書による事前の承諾を得ることなく転載または複製することを固くお

断りいたします。 
12. 本資料に関する詳細についてのお問い合わせその他お気付きの点等がございましたら当社営業窓口までご

照会ください。 
 
注 1. 本資料において使用されている「当社」とは、ルネサスエレクトロニクス株式会社およびルネサスエレク

トロニクス株式会社がその総株主の議決権の過半数を直接または間接に保有する会社をいいます。 
注 2. 本資料において使用されている「当社製品」とは、注 1 において定義された当社の開発、製造製品をいい

ます。 



資料中の「三菱電機」、「三菱XX」等名称の株式会社ルネサス テクノロジへの変更について

　2003年4月1日を以って株式会社日立製作所及び三菱電機株式会社のマイコン、ロジック、

アナログ、ディスクリート半導体、及びDRAMを除くメモリ(フラッシュメモリ・SRAM等)を含む

半導体事業は株式会社ルネサス テクノロジに承継されました。

従いまして、本資料中には「三菱電機」、「三菱電機株式会社」、「三菱半導体」、「三菱XX」といっ

た表記が残っておりますが、これらの表記は全て「株式会社ルネサス テクノロジ」に変更され

ておりますのでご理解の程お願い致します。尚、会社商標・ロゴ・コーポレートステートメント

以外の内容については一切変更しておりませんので資料としての内容更新ではありません。

注：「高周波・光素子事業、パワーデバイス事業については三菱電機にて引き続き事業運営を

    行います。」

2003年4月1日

株式会社ルネサス テクノロジ

カスタマサポート部

お客様各位

お問い合わせ先変更のお知らせ
2003年4月1日、三菱電機セミコンダクタ・アプリケーション・エンジニアリング株式会社は、株式会社ルネサス ソリューションズに社名変更いたしました。ドキュメントに記載されている旧メールアドレスおよびURLは以下のとおり最新のものに読み替えをお願いいたします。

■ユーザ登録窓口
旧：regist@tool.mesc.co.jp（使用できません）
　　regist@tool.maec.co.jp（2003年7月1日まで使用可）
新：regist_tool@renesas.com

■ツール技術サポート窓口
旧：support@tool.msc.hoku.melco.co.jp（使用できません）
　　support@tool.mesc.co.jp（使用できません）
　　support@tool.maec.co.jp（2003年7月1日まで使用可）
新：support_tool@renesas.com

■ツールホームページ
旧：http://www.tool-spt.mesc.co.jp/（使用できません）
　　http://www.tool-spt.maec.co.jp/（2003年7月1日まで使用可）
新：http://www.renesas.com/jp/tools

■社名
旧：三菱電機セミコンダクタソフトウエア(株)
　　三菱電機セミコンダクタシステム(株)
　　三菱電機セミコンダクタ・アプリケーション・エンジニアリング(株)
新：株式会社ルネサス ソリューションズ

ツールニュース「新会社設立のお知らせ」
http://www.renesas.com/jpn/products/mpumcu/toolhp/toolnews/n030401/tn1.htm

■製品形名変更について
ソフトウェアツールおよび一部のアクセサリツールでは、製品形名の体系の見直しに伴い、順次製品形名を変更させていただきました。一部ドキュメント中では、旧製品形名で表記している場合がありますが、ご了承ください。製品名変更についての詳細は下記URLをご参照ください。

http://www.renesas.com/jpn/products/mpumcu/toolhp/henkou/index_j.htm
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《安全設計に関するお願い》
三菱電機株式会社・三菱電機セミコンダクタシステム株式会社は品質、信頼性の向上に努めておりますが、半導体製品は故障が
発生したり、誤動作する場合があります。弊社の半導体製品の故障又は誤動作によって結果として、人身事故、火災事故、社会的
損害などを生じさせないような安全性を考慮した冗長設計、延焼対策設計、誤動作防止設計などの安全設計に十分ご留意くだ
さい。

《本資料ご利用に際しての留意事項》
●本資料は、お客様が用途に応じた適切な三菱半導体製品をご購入いただくための参考資料であり、本資料中に記載の技術情報
について三菱電機株式会社・三菱電機セミコンダクタシステム株式会社が所有する知的財産権その他の権利の実施、使用を許
諾するものではありません。

●本資料に記載の製品データ、図、表、プログラム、アルゴリズムその他応用回路例の使用に起因する損害、第三者所有の権利に対
する侵害に関し、三菱電機株式会社・三菱電機セミコンダクタシステム株式会社は責任を負いません。

●本資料に記載の製品データ、図、表、プログラム、アルゴリズムその他全ての情報は本資料発行時点のものであり、三菱電機株式
会社・三菱電機セミコンダクタシステム株式会社は、予告なしに、本資料に記載した製品または仕様を変更することがあります。
三菱半導体製品のご購入に当たりましては、事前に三菱電機株式会社・三菱電機セミコンダクタシステム株式会社または特約
店へ最新の情報をご確認頂きますとともに、三菱電機半導体情報ホームページ（http://www.semicon.melco.co.jp/）および三菱開
発ツールホームページ（http://www.tool-spt.mesc.co.jp/）などを通じて公開される情報に常にご注意ください。

●本資料に記載した情報は、正確を期すため、慎重に制作したものですが万一本資料の記述誤りに起因する損害がお客様に生じ
た場合には、三菱電機株式会社・三菱電機セミコンダクタシステム株式会社はその責任を負いません。

●本資料に記載の製品データ、図、表に示す技術的な内容、プログラム及びアルゴリズムを流用する場合は、技術内容、プログラム、
アルゴリズム単位で評価するだけでなく、システム全体で十分に評価し、お客様の責任において適用可否を判断してください。
三菱電機株式会社・三菱電機セミコンダクタシステム株式会社は、適用可否に対する責任は負いません。

●本資料に記載された製品は、人命にかかわるような状況の下で使用される機器あるいはシステムに用いられることを目的とし
て設計、製造されたものではありません。本資料に記載の製品を運輸、移動体用、医療用、航空宇宙用、原子力制御用、海底中継用
機器あるいはシステムなど、特殊用途へのご利用をご検討の際には、三菱電機株式会社・三菱電機セミコンダクタシステム株式
会社または特約店へご照会ください。

●本資料の転載、複製については、文書による三菱電機株式会社・三菱電機セミコンダクタシステム株式会社の事前の承諾が必要
です。

●本資料に関し詳細についてのお問い合わせ、その他お気付きの点がございましたら三菱電機株式会社・三菱電機セミコンダク
タシステム株式会社または特約店までご照会ください。

製品の内容及び本書についてのお問い合わせ先
電子メールの場合： インストーラが生成する以下のテキストファイルに必要事項を記入の上、開発ツールサポート窓口

support@tool.mesc.co.jpまで送信ください。

Windows 98/95/Windows NT 4.0版：¥SUPPORT¥製品名¥SUPPORT.TXT
EWS版：/support/製品名/toolinfo.txt

FAXの場合： 各ユーザーズマニュアル及びガイドブックの最後に添付されている「技術サポート連絡書」に必要事項
を記入の上、開発ツールサポート窓口まで送信ください。FAX送信先は「技術サポート連絡書」に記載し
てあります。

Microsoft、MS-DOS、WindowsおよびWindows NTは、米国Microsoft Corporationの米国およびその他の国における登録商標です。
HP-UXは、米国Hewlett-Packard Companyのオペレーティングシステムの名称です。
SolarisおよびSunは、米国およびその他の国における米国Sun Microsystems, Inc.の商標または登録商標です。
UNIXは、X/Open Company Limitedが独占的にライセンスしている米国ならびに他の国における登録商標です。
IBMおよびATは、米国International Business Machines Corporationの登録商標です。
HP 9000は、米国Hewlett-Packard Companyの商品名称です。
SPARCおよびSPARCstationは、米国SPARC International, Inc.の登録商標です。
Intel, Pentiumは、米国Intel Corporationの登録商標です。
AdobeおよびAcrobatは、Adobe Systems Incorporated（アドビシステムズ社）の登録商標です。
NetscapeおよびNetscape Navigatorは、米国およびその他の諸国のNetscape Communications Corporation社の登録商標です。
その他すべてのブランド名および製品名は個々の所有者の登録商標もしくは商標です。
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はじめに

はじめに

このユーザーズマニュアルをお読みになる前に、製品に添付されているリリースノート
を必ずお読みください。製品構成、製品の扱い、注意事項などの重要な内容が記述されてい
ます。

■対象読者

このユーザーズマニュアルでは、次の方を対象としています。

� C言語による組み込み用プログラム開発およびデバッグ経験のある方
� 三菱統合化開発環境を初めてご使用になる方

■参考マニュアル

三菱統合化開発環境 (TM)に関する詳しい用語説明、機能説明、操作については、次のマ
ニュアルを参照してください。このマニュアルはオンラインでも参照することができます。

� 三菱開発サポートツール用統合化開発環境
TM V.2.00ユーザーズマニュアル
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Chapter 1: 基礎知識編

1 基礎知識編

1.1 TW32Rのソフトウェア構成

TW32Rは、次のソフトウェアから構成されています。

�統合化開発環境 (TM)

GUI(Graphical User Interface)操作による、コンパイラ、アセンブラ、リンカなどの Cコン
パイラ系ツールの制御機能をサポートし、アプリケーションプログラムの開発作業を効率よ
く実施するための開発ツールです。また、アプリケーションプログラムを構成するソースファ
イルの情報も管理します。

�M32R用 GNU Cコンパイラ系ツール

M32R用 GNU Cコンパイラ系ツールを同梱しています。M32R用 GNU C コンパイラ系
ツールのコマンドは、GNU標準のコマンド名の前に、`m32r-elf-'が付いたコマンド名になっ
ています。次のコマンドより構成されています。1

m32r-elf-gcc

Cコンパイラ

m32r-elf-as

アセンブラ

m32r-elf-ld

リンカ

m32r-elf-ar

アーカイブツール

m32r-elf-ranlib

アーカイブインデックス作成ツール

m32r-elf-objcopy

オブジェクトコピー、変換ツール

m32r-elf-strip

シンボル削除ツール

m32r-elf-nm

オブジェクトシンボル表示ツール

m32r-elf-objdump

オブジェクト情報表示ツール

m32r-elf-size

オブジェクトサイズ表示ツール

m32r-elf-strings

文字列表示ツール

1 これらの GNUツールの扱いは、GNU General Public Licenseに従います。
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�三菱製 ANSI C標準ライブラリ

三菱製ANSI C準拠の C標準ライブラリ (libc.a)と数値計算ライブラリ (libm.a)が含まれて
います。

1.2 ツールのドキュメント

各ツールの使用方法、説明に関する詳細は、TW32Rに含まれているドキュメントを参照
してください。2 ドキュメントは、スタートメニューから選択して参照することができます。
それぞれ、次のようにメニューを選択してください3 。

�TMのドキュメント (PDF形式、日本語)

� �

[スタート] → [プログラム] → [MITSUBISHI-TOOL] →
[TM V.2.01] → TMユーザーズマニュアル


 	

�M32R用 GNU Cコンパイラ系ツール (HTML形式および PDF形式、英語)

� �

[スタート] → [プログラム] → [MITSUBISHI-TOOL] →
[TW32R V.3.10 Release 1] → TW32Rドキュメント


 	

�三菱製 ANSI C標準ライブラリ (HTML形式および PDF形式、日本語)

� �

[スタート] → [プログラム] → [MITSUBISHI-TOOL] →
[TW32R V.3.10 Release 1] → TW32Rドキュメント


 	

1.3 TMのウインドウ構成

TMのウインドウ (Mainウインドウ)は、次の部分から構成されています。

�メニューバー
TMを操作するためには、このメニューバーから機能を選択します。メニューを
選択することにより、TMの全ての機能を実行できます。

2
PDF形式のドキュメントを参照する場合、Acrobat Reader 3.0Jがインストールされて
いる必要があります。また、HTML形式のドキュメントを参照する場合、HTML形式のド
キュメントを表示可能なブラウザまたは同等のツールがインストールされている必要があ
ります。

3 スタートメニューに登録されるショートカット名は、TW32Rのバージョンにより異なる
ため、ここに示したバージョン番号と異なることがあります。
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�ツールバー
メニューバーから選択できる機能のうち、使用頻度の高いものをツールバーに
ボタンとして配置してあります。メニューバーから選択するのと同様に使用でき
ます。

�ツリーウインドウ
プロジェクトに含まれるターゲットファイル、ソースファイル、ヘッダファイル
をアイコンで階層的に表示します。また、関数の依存関係もビジュアルに表示し
ます。

�ビューウインドウ
ソースファイルの内容を表示します。ツリーウインドウでファイルのアイコン (ま
たはファイル名)をクリックすると、ファイルの内容がビューウインドウに表示
されます。

�Outputウインドウ
コンパイル、アセンブル、リンクの実行フェーズや実行結果を表示します。また、
外部ツールの実行結果も表示します。

�ステータスバー
ツールバーの各ボタン上にマウスカーソルを合わせた時に、そのボタン機能の簡
易説明を表示したり、TMの状態を表示したりします。

図 1. TMのウインドウ構成
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1.4 TMのプロジェクト管理

TMはプロジェクトという単位で、アプリケーションの開発環境を管理します。開発環境
には次の情報が含まれています。

� アプリケーションのターゲット MCU

� アプリケーションの構成ファイル (Cソースファイル、インクルードファイル)

� アプリケーションのターゲットプログラム名
� クロスツールおよびオプション
� デバッガ
� エディタ
� 環境変数

TMは、これらの情報を `プロジェクト名.mtm'ファイルにまとめて管理し、これらの情報
を参照して、ターゲットプログラムファイルであるロードモジュール (実行形式ファイル)を
作成します。

1.5 TMを使ったプログラム開発手順の概要

TMを使用したプログラム開発の手順は、以下のようになります。

(1)プロジェクトの作成
プロジェクトを作成し、使用するエディタ、アプリケーションの構成ファイル、
クロスツール、オプション、デバッガなどを登録します。

(2)ビルドの実行
ビルドの実行により、プロジェクトの登録内容に従ってコンパイラ、アセンブラ、
リンカが起動されターゲットプログラムが生成されます。

(3)デバッグの実行
プロジェクトに登録されているデバッガが起動され、ターゲットプログラムのデ
バッグをすることができます。

� 6�



Chapter 2: 開発工程編

2 開発工程編

2.1 TMを起動する

TMを実際に使ってみましょう。

ここでは、"Hello World!"のプログラムを作成し、モトローラ S-recordファイル1 を作成す
るまでの例を示しながら説明します。

TMを起動するには、Windowsのスタートメニューを利用してください。インストールが
完了していれば、次のようにメニューを選択することにより起動できます2 。
� �

[スタート] → [プログラム (P)] → [MITSUBISHI-TOOL] →
[TM V.2.01] → TM


 	

2.2 プロジェクトを作成する

ターゲットプログラムを作成するためには、まず新規プロジェクトを作成します。新規プ
ロジェクトの作成は、以下の手順で行います。

2.2.1 ターゲット CPUの選択

TMメニューから [File]→ [New Project...]を選択3 します。これにより、新規プロジェクト
設定ウィザード (New Project Wizard - Page 1)がオープンします。この Page 1で次の項目を設
定してください。

�Target Chip
使用するマイコンのファミリ名もしくはグループ名を選択します。
ここではM32R Familyを選択してください。

�Project Name
プロジェクト名を指定します。
プロジェクト名は、プロジェクトを区別するために使用されます。また、ターゲッ
トファイル名はプロジェクト名に拡張子 (M32R Familyの場合、".x")が付けられ
ます。
例えば、プロジェクト名として `hello'を指定した場合、ターゲットファイル名
は `hello.x'になります。ここでは `hello' と入力してください。

1 モトローラ形式の Sフォーマット
2 スタートメニューに登録されるショートカット名は、TMのバージョンにより異なるため、
ここに示したバージョン番号と異なることがあります。

3 ツールバーの左端のボタンをクリックすることでも同様に、新規プロジェクト設定ウィ
ザードをオープンできます。
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プロジェクト名には、任意の名前を指定することができますが、ディレクトリ名
として使用できない文字は指定できません。

�Working Directry
プロジェクトの作業ディレクトリのパスを指定します。作業ディレクトリが希望
のパス位置になるようにドライブレター付きでパスを指定してください。任意
のパスが指定できますが、ディレクトリ名として使用できない文字は指定できま
せん。

図 2.新規プロジェクト作成ウインドウ 1

2.2.2 ツールの選択

[次へ>]ボタンを押し、次のウインドウ画面に移動します。これにより、New Project Wizard

- Page 2がオープンします。この Page 2で次の項目を設定してください。

�Compiler Package
使用するクロスツール名を指定します。ここではM32R用統合クロスツールキッ
ト TW32Rを選択してください。

チェックボックスをチェックすると、C言語の開発に必要なファイルを使用でき
るようにします。通常は、チェックしておくことを推奨します。ここではチェッ
クしておきます。

図 3. 新規プロジェクト作成ウインドウ 2
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2.2.3 OSパッケージおよびデバッガパッケージの選択

[次へ>]ボタンを押し、次のウインドウ画面に移動します。

これにより、New Project Wizard - Page 3がオープンします。この Page 3では、リアルタ
イムOSを使用する場合のパッケージを設定します。今回の例では使用しないので、そのまま
[次へ>] ボタンを押し、次のウインドウ画面に移動します。

また、次の New Project Wizard - Page 4では、使用するデバッガのパッケージを選択しま
す。今回の例では使用しないので、そのまま [次へ>]ボタンを押し、次のウインドウ画面に移
動します。

2.2.4 プロジェクトの設定確認

[次へ>]ボタンを押し、次のウインドウ画面に移動します。これにより、New Project Wizard

- Page 5がオープンします。ここで設定内容を確認してください。

図 4. 新規プロジェクト作成ウインドウ 3

これらの設定が正しければ [完了]ボタンを押し、プロジェクトの作成を完了します。設定
を変更したい場合、[<戻る]ボタンを押し、設定をやり直してください。

プロジェクトの作成が完了すると、File Treeウインドウ画面にプロジェクトファイルのフォ
ルダアイコン `hello.mtm'が表示されます。このフォルダ以下に、このプロジェクトを構成す
る Target File、Source File、Header Fileが階層的に管理されます。
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図 5. 新規プロジェクト作成ウインドウ 4

2.3 ソースファイルを登録する

プロジェクトにソースファイルを登録するには、メニューから [Environment]→ [Add Source

File]→ [Select File...] を選択し、登録するソースファイル名を指定します。新規ファイルを作
成する場合には、[New File...]を選択します。

ここでは [New File...]を選択し、ファイル名に `hello.c'を指定して新規作成で登録してく
ださい。

TMには、デフォルトのエディタとしてメモ帳 (Notepad.exe)が登録されていますので、
ここでは、メモ帳が起動され `hello.c'の新規ファイルがオープンされます。ここで以下のプ
ログラムを入力し、上書き保存してエディタを終了してください。
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� �

#include <stdio.h>

main()

{

printf("Hello World!\n");

}

 	

2.4 ビルド (コンパイル、リンク)を実行する

ツールバーの<Build>ボタンをクリックするか、メニューから [Action] → [Build] を選択し
てプロジェクトのビルドを実行してください。ビルドとリビルド作業の内容は次の通りです。

�ビルド コンパイル、アセンブル、リンクを実行してターゲットプログラムを生成します。
makeユーティリティの機能を利用して、ソースファイルなどに変更があった場合
のみコンパイル、アセンブル、リンクを実行します。

�リビルド ソースファイルの修正の有無に関わらず全てのソースファイルをコンパイル、ア
センブル、リンクします。日付の古いソースファイルをコピーし、再コンパイル、
再アセンブル、再リンクしたい場合などに使用します。

2.5 ビルド (リビルド )の経過及び結果の確認

ビルド (リビルド)を実行すると、実行状況がOutputウインドウに表示されます。各フェー
ズの実行状況を確認してください。
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図 6. ビルドの実行

2.6 ソースファイルを編集する

ソースファイルの記述に間違いがあればファイルを編集し修正します。ファイルの編集を
行うには、File Treeに表示されているソースファイルをダブルクリックします。これにより
プロジェクトに登録されているエディタが起動され、ファイルがオープンされます。

ソースファイルを修正できたら、再びビルドを実行します。

2.7 モトローラ S-recordファイルを作成する

作成したターゲットプログラム `hello.x'をモトローラ S-recordファイルに変換してみま
しょう。

ここでは、TMの Other Tool機能を使用して、モトローラ S-record ファイルへの変換ツー
ル (m32r-elf-objcopy)の起動により変換します。変換作業は以下の手順で行います。

1. メニューから [Action] → [Other] → [m32r-elf-objcopy] を選びます。
2. Parameterに `-O srec hello.x hello.mot'と入力します。

`-O srec'は S-record変換、`hello.x'は入力ファイル、`hello.mot'は出力ファイルをそ
れぞれ示します。

3. <OK>ボタンをクリックします。
4. これでWorking Directoryディレクトリに、`hello.mot'の S-recordファイルが作成され
ます。　

図 7. Other Toolの実行 (Tool Execute)ウインドウ

2.8 プロジェクトを保存する

ツールバーの<Save Project>ボタンをクリックするか、メニューから [File]→ [Save Project]

を選択し、作成したプロジェクトを保存します。プロジェクトは、プロジェクト名.MTM(拡
張子が.MTM)というファイル名で保存されます。ここでは `hello.mtm'というファイルに保
存されます。

保存したプロジェクトファイルをオープンすることにより、同じ設定でプロジェクトに対
する作業を再開できます。
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3 基本操作編

3.1 ヘルプを参照する

メニュー [Help] → [Help Topics] から目的のファイルを選択し、ヘルプ画面を表示します。

3.2 TMからオンラインマニュアルを参照する

オンラインマニュアルを参照するには、メニュー [Help]→ [Online Manual]から目的のファ
イルを選択し、オンラインマニュアルを表示します。次のオンラインマニュアルを参照する
ことができます。

� TM ユーザーズマニュアル (PDF形式)

� TW32Rドキュメント (PDF形式および HTML形式)

ただし、PDF形式のオンラインマニュアルを表示するためには、Acrobat Reader 3.0Jが
インストールされている必要があります。HTML形式のオンラインマニュアルを表示するた
めには、HTMLドキュメントを表示可能なブラウザまたは同等のツールがインストールされ
ている必要があります。また、プロジェクトが読み込まれていない場合は、TW32Rのオンラ
インマニュアルは参照できません。

3.3 コンパイラのオプション設定

コンパイラのオプション設定は、次の手順で行います。

1. メニューから [Environment] → [Build Settings]を選択します。

2. Build Settingsダイアログの左側に表示されているツールのツリーから C Compilerを選
択します。

3. Build Settingsダイアログの右側の Groupから、変更するオプショングループを選択し
ます。

4. Groupの下に表示されるオプション一覧より、Optionのチェックボックスをクリックし
てオプションを設定します。

5. All Sourceボタンを押します。

6. <OK>ボタンをクリックし、Build Settingsダイアログを閉じます。
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この設定は、全ての C言語ソースに対して有効1 になります。

図 8. コンパイラオプション設定ウインドウ

3.4 アセンブラのオプション設定

アセンブラのオプション設定は、次の手順で行います。

1. メニューから [Environment] → [Build Settings]を選択します。

2. Build Settingsダイアログの左側に表示されているツールのツリーから Assemblerを選択
します。

3. Groupの下に表示されるオプション一覧より、Optionのチェックボックスをクリックし
てオプションを設定します。

4. All Sourceボタンを押します。

5. <OK>ボタンをクリックし、Build Settingsダイアログを閉じます。

1 ソースファイル名を選択後、オプション設定を変更することにより、ファイル毎のオプ
ションも設定することができます。
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この設定は、全てのアセンブリ言語ソースに対して有効になります。2

図 9. アセンブラオプション設定ウインドウ

3.5 リンカのオプション設定

リンカのオプション設定は、次の手順で行います。

1. メニューから [Environment] → [Build Settings]を選択します。

2. Build Settingsダイアログの左側に表示されているツールのツリーから Linkerを選択し
ます。

3. Groupの下に表示されるオプション一覧より、Optionのチェックボックスをクリックし
てオプションを設定します。

4. All Sourceボタンを押します。

5. <OK>ボタンをクリックし、Build Settingsダイアログを閉じます。

2 ソースファイル名を選択後、オプション設定を変更することにより、ファイル毎のオプ
ションも設定することができます。
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図 10. リンカオプション設定ウインドウ

3.6 メモリモデルの設定/変更

メモリモデル設定/変更は、次の 2点を設定します。また、設定を変更した場合、リビルド
する必要があります。

� Cコンパイラのオプション-mmodel=<mmodel-name>に、対応するメモリモデルを指定
します。

� リンカのオプション-mmodel=<mmodel-name>に、対応するメモリモデルを指定します。

Cコンパイラとリンカのメモリモデルオプションの設定は、次の手順で行います。

1. メニューから [Environment] → [Build Settings]を選択します。
2. Build Settingsダイアログの左側に表示されているツールのツリーから C Compilerを選
択します。

3. Build Settingsダイアログの右側のGroupから、コード/データモデルのオプショングルー
プを選択します。

4. Groupの下に表示されるオプション一覧より、̀-mmodel='オプションの行を選択してPa-
rameter...ボタンを押します。

5. Select Optionsダイアログ中のOptionから、該当するメモリモデルのチェックボックス
をクリックします。クリックしたら OKボタンを押し、Select Options ダイアログをク
ローズします。

6. All Sourceボタンを押します。
7. 次に Build Settingsダイアログ左側に表示されているツールのツリーから Linkerを選択
し、C Compilerの場合と同様にオプションを指定します。

8. <OK>ボタンをクリックし、Build Settingsダイアログを閉じます。
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4 基本編集編

4.1 リンカスクリプトの概要

TW32Rにおける TM環境では、プログラムのロードモジュール作成 (ビルドおよびリビル
ド作業)時にリンカスクリプトを利用します。リンカスクリプトは、ロードモジュール作成に
関する次の情報を定義するものです。

� 入力オブジェクトファイル

� デフォルトのオブジェクトおよびライブラリ検索パス

� デフォルトの入力ライブラリ

� 入出力ファイルのフォーマット

� 出力ファイルのアーキテクチャ

� プログラムのエントリアドレス

� メモリレイアウト

� セクションレイアウト (メモリ配置、実行アドレス、ロードアドレス)

開発中のターゲットプログラム (プロジェクト)に最適なように、これらの情報を編集し定
義することができます。リンカスクリプトは、新規プロジェクトを作成した時に、サンプルの
リンカスクリプト `m32r.cmd'がそのプロジェクト用にWorking Directoryにコピーされます。
TMでは、コピーされたリンカスクリプトを利用してターゲットプログラムをリンクします。

4.2 リンカスクリプトの編集

リンカスクリプト `m32r.cmd'を編集するには、メニューから [Environment]→ [Section] を
選択します。TMに登録されているエディタが起動され、`m32r.cmd' ファイルがオープンさ
れます。

4.3 リンカスクリプトの詳細

サンプルのリンカスクリプトの各部について説明します。記述方法に関する詳細は、リン
カ `ld'のドキュメントを参照してください。

4.3.1 入力オブジェクトファイルの定義

入力オブジェクトファイルの定義は、TMのプロジェクト管理機能により自動管理および
更新されます。この定義は、次のキーワードで囲まれた部分に対して、TMがロードモジュー
ル作成時 (ビルドおよびリビルド時)に適切に自動編集します。
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� 入力オブジェクトファイル
� �

/*[MTM_INPUT_TOP]*/

TMが入力オブジェクトファイルに関する情報を出力
/*[MTM_INPUT_END]*/

 	

したがって、これらのキーワードの削除や変更、キーワード間の編集は行わないでくださ
い。また、TMの管理している入力オブジェクト以外のオブジェクトファイルを入力指定した
い場合、これらのキーワードの範囲外に定義してください。

4.3.2 デフォルトのオブジェクトおよびライブラリ検索パスの定義

デフォルトのオブジェクトおよびライブラリ検索パスの定義は、TMのプロジェクト管理
機能により自動管理および更新されます。この定義は、次のキーワードで囲まれた部分に対
して、TMがロードモジュール作成時 (ビルド及びリビルド時)に適切に自動編集します。

� デフォルトのオブジェクトおよびライブラリ検索パス
� �

/*[MTM_SEARCH_DIR_TOP]*/

　 TMがデフォルトのオブジェクトおよびライブラリ検索パスを出力
/*[MTM_SEARCH_DIR_END]*/

 	

したがって、これらのキーワードの削除や変更、キーワード間の編集は行わないでくだ
さい。また、TMの管理している検索パス以外のパスを優先して検索パス指定したい場合、
MTM_SEARCH_DIR_TOPキーワードより前に定義してください。

4.3.3 デフォルトの入力ライブラリの定義

デフォルトの入力ライブラリの定義は、TMのプロジェクト管理機能により自動管理および
更新されます。この定義は、次のキーワードで囲まれた部分に対して、TMがロードモジュー
ル作成時 (ビルド及びリビルド時)に適切に自動編集します。

� デフォルトの入力ライブラリ
� �

/*[MTM_GROUP_TOP]*/

　 TMがデフォルトの入力ライブラリを出力
/*[MTM_GROUP_END]*/

 	

したがって、これらのキーワードの削除や変更、キーワード間の編集は行わないでくださ
い。また、TMの管理しているデフォルトの入力ライブラリ以外のライブラリを優先して指
定したい場合、MTM_GROUP_TOP キーワードより前に定義してください。
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4.3.4 入出力ファイルフォーマットの定義

入力オブジェクトフォーマットおよび出力オブジェクトフォーマットを指定します。この
定義の変更や削除は行わないでください。
� �

OUTPUT_FORMAT("elf32-m32r", "elf32-m32r", "elf32-m32r")

 	

4.3.5 出力ファイルのアーキテクチャの定義

出力ファイルのアーキテクチャを指定します。この定義の変更や削除は行わないでくだ
さい。
� �

OUTPUT_ARCH(m32r)

 	

4.3.6 エントリアドレスの定義

プログラムのエントリアドレス (シンボル)を定義します。ユーザープログラムのエントリ
アドレスを指定してください。

サンプルのリンカスクリプトでは、サンプルのスタートアッププログラム `crt0.S'用のエ
ントリアドレスとして__rom_startが指定されています。
� �

ENTRY(__rom_start)

 	

4.3.7 メモリレイアウトの定義

メモリレイアウトを定義し、各セクションがここで定義したメモリのどこに配置されるか
を指定することにより、セクションの配置指定とオーバーフローチェックを行うことができま
す。サンプルのリンカスクリプトでは、メモリレイアウトの定義のみ行っており、配置指定
には使用していません。
� �

MEMORY

{

in ram1 : org = 0, len = 1M

in ram2 : org = 0, len = 2M

in ram4 : org = 0, len = 4M

out rom1 : org = 0x7fe00000, len = 1M

}
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セクション配置とオーバーフローを正しくチェックする場合、これらのメモリレイアウト
定義をターゲットのメモリ構成に合わせて適切に編集し、各セクションをメモリのどこに配
置するか指定してください。

全てのオブジェクトの.textセクションが、in ram1で定義したメモリに配置されるよう
に指定するには、SECTIONS定義内で次のように記述します。
� �

SECTIONS {

.text : { *(.text) } > in ram1
}

 	

4.3.8 セクションの定義

リンクするセクションの指定および配置指定を定義します。サンプルのリンカスクリプト
では、セクションの定義は基本的に次のように定義しています。

SECTIONS {

/* 実行時開始アドレス定義のシンボル */

START OF RAM = 0x100;

/* ロード時開始アドレス定義のシンボル */

START OF ROM = 0x100;

/* リセットベクタアドレス定義のシンボル */

RESET = 0x7ffffff0;

/* ロケーションカウンタの設定 */

. = START OF RAM;

/* 実行時アドレスとロード時アドレスを指定したセクション */

出力セクション名 (実行時アドレス) : AT(ロード時アドレス)

{

/* 実行時のセクション開始アドレス */

入力セクション名 start = .;

/* 全てのセクション配置指定 */

*(入力セクション名)

/* 実行時のセクション終了アドレス */

入力セクション名 end = .;

}

/* ロード時のセクション開始アドレス */

rom 入力セクション名 = LOADADDR(出力セクション名);

：
：
/* 実行時アドレスの指定のみ */

　出力セクション名 :
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{

/* 実行時のセクション開始アドレス */

入力セクション名 start = .;

/* 全てのセクション配置指定 */

*(入力セクション名)

/* 実行時のセクション終了アドレス */

入力セクション名 end = .;

}

：
：

}

この定義中のシンボルや用語は、それぞれ次のことを示しています。

�入力セクション名
オブジェクト内に含まれるセクション名を示しています。

�出力セクション名
ロードモジュールに出力されるセクション名を示しています。

�実行時開始アドレス
プログラムやデータが実行される時に配置される開始アドレスを示しています。

�ロード時開始アドレス
プログラムの実体がロード時に配置されるアドレスを示しています。

� 入力セクション名 startシンボル
� 入力セクション名 endシンボル
� rom 入力セクション名シンボル

サンプルのスタートアッププログラム `crt0.S'内で各セクションの転送 (ROMか
ら RAMへの転送、あるいは、低速 RAMから高速 RAMへの転送)時に参照する
ために定義してあるグローバルシンボルであり、スタートアッププログラムとの
整合をとる必要があります。

サンプルのリンカスクリプトでは、以下のセクションを定義しています。

.start スタートアッププログラムのセクション

.init Cおよび C++用初期化処理プログラムのセクション

.text コードのセクション

.�ni Cおよび C++用終了処理プログラムのセクション

.rodata 初期値あり読み出し専用データのセクション

.data 初期値あり読み書きデータのセクション

.ctors C++用グローバルコンストラクタテーブルのセクション

.dtors C++用グローバルデストラクタテーブルのセクション

.sdata 初期値あり small data areaのセクション

.sbss 初期値なし small data areaのセクション
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.bss 初期値なしデータのセクション

.heap 標準ライブラリで使用するヒープのセクション

.spu stack ユーザースタックのセクション

.spi stack 割り込みスタックのセクション

.reset リセットベクタのセクション

サンプルのリンカスクリプトでは、.startから.spi_stack までのセクションは、0x100

番地からこの順番に連続に配置されるように定義しています。また、これらのセクションは、
START OF RAMシンボル値 (実行時の開始アドレス)と START OF ROMシンボル値 (ロー
ド時の開始アドレス)が同一となるよう定義しています。すなわち、プログラムコード及び
データの実体は、プログラム実行時のメモリに配置されます。
� �

メモリマップイメージ
| |

0x00000100 +----------------+ START OF RAM
| .start | ==START OF ROM
| : | == start start
| .spi_stack |

+----------------+ spi end
| |

0x7ffffff0 +----------------+ RESET
| .reset |

+----------------+

 	

START OF RAMシンボルと START OF ROMシンボルを別々のアドレスに定義1 する
ことにより、実行時のアドレスとロード時のアドレスをそれぞれ指定することができます。

例えば、START OF RAMをRAM領域、START OF ROMをROM領域に定義すること
により、ROM化可能なロードモジュールを作成することができます。この場合、サンプルのリ
ンカスクリプトでは.sbssセクションから.spi_stackセクションまでは、実行時のアドレスに
そのまま配置されます。以下に START OF RAMに 0x100番地を指定し、START OF ROM
に 0x400000番地を指定した場合のメモリマップイメージを示します。

1 実行時のアドレス範囲とロード時のアドレス範囲がオーバーラップしないように注意し
てください。
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� �

メモリマップイメージ
| |

0x00000100 +----------------+ START OF RAM
| .start | == start start
| : |

| .sdata |

+----------------+ sbss start
| .sbss |

| : |

| .spi_stack |

+----------------+ spi end
| |

0x00400000 +----------------+ START OF ROM
| .start | == rom start
| : |

| .sdata |

+----------------+

| |

0x7ffffff0 +----------------+ RESET
| .reset |

+----------------+

 	

.resetセクションは、リセットベクタ用のセクションであり、RESETシンボル値で定義
したアドレスにプログラムコードを配置するための定義です。
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次に、実際のセクション定義の一部について説明します。
� �

：
：
.start (START OF RAM) :

AT(START OF ROM)

{

start start = .;

*(.start)

start end = .;

}

rom start = LOADADDR(.start);

.init (ADDR(.start)+SIZEOF(.start)) :

AT( LOADADDR(.start) + SIZEOF(.start) )

{

init start = .;

*(.init)

init end = .;

} =0

：
：

 	

この定義は、.startセクションと.initセクションを定義している部分です。

.startセクションでは、実行時アドレスが START OF RAM シンボルで定義されたアド
レス、ロード時アドレスが START OF ROM シンボルで定義されたアドレスに配置するこ
とを定義しています。

次に、この.startセクションの実行時の開始シンボルとして start startを定義し、この
時のロケーションカウンタの値 (.)を設定しています。

*(.start)は、全ての入力ファイル (*)の.startというセクションを配置することを定義
しています。

そして、.startセクションの実行時の終了シンボルとして start endシンボルを定義し、
この時のロケーションカウンタの値 (.)を指定しています。

rom start=LOADADDR(.start)は、 rom startシンボルを定義し、このシンボルに.start

セクションのロード時開始アドレスを設定しています。

.initセクションは、実行アドレスが、.startセクションの実行時アドレスと.startセ
クションのサイズを加算したアドレス位置から開始することを定義し、ロードアドレスが、
.start セクションのロード時アドレスと.startセクションのサイズを加算したアドレス位
置から開始することを定義しています。
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init start=.と init end=.の定義は、.startセクションの定義の場合と同じく、.init
セクションの実行時の開始アドレスと終了アドレスを定義しています。

最後の}=0は、セクションがアライメント調整のためにパディングされた場合、データと
して 0を埋め込むことを定義しています。

4.4 スタートアッププログラム処理概要

サンプルのスタートアッププログラム (crt0.S)では、次の処理行っています。

� PSW初期値の設定
サンプルでは、初期値として 0x80(割り込み禁止、ユーザー用スタックポインタを使用)

を設定しています。
� 割り込みスタック (SPI)ポインタの初期値の設定

`crt0.S'で確保した領域を初期値として設定しています。
� ユーザースタック (SPU)ポインタの初期値の設定

`crt0.S'で確保した領域を初期値として設定しています。
� 戻り番地保持レジスタの初期値の設定

R14レジスタに初期値として 0を設定しています。
� 初期値なしデータ領域の 0クリア

.sbssセクションと.bssセクションを 0クリアします。.bssセクションのクリア例を以
下に示します。
� �

; (.bss)

seth r3, #high(__bss_start)

or3 r3, r3, #low(__bss_start) ; r3: start of

; .bss section

seth r4, #high(__bss_end)

or3 r4, r4, #low(__bss_end) ; r4: end of .bss

; section + 1

sub r4, r3 ; r4: .sbss section

; size(bytes)

blez r4, .Lendloop_bss ; if size <= 0

; break

ldi r2, #0

.Lloop_bss:

stb r2, 3

addi r3, #1

addi r4, #-1

bgtz r4, .Lloop_bss

.Lendloop_bss:

 	

ただし、0 クリアのために参照しているグローバルシンボルは、サンプルのリンカスク
リプト内で定義されたシンボルを使用しています。従って、この処理はリンカスクリプ
トの定義と整合をとる必要があります。

� 各セクションの転送処理
ロード時のアドレスから実行時のアドレスへ各セクションの内容を転送しています。一
般には、ROMから RAMへの転送あるいは低速 RAMから高速 RAMへ転送するために、
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この処理を行います。
ここでは、以下のセクションの転送処理を行っています。

.start スタートアッププログラムのセクション

.init Cおよび C++用初期化処理プログラムのセクション

.text コードのセクション

.fini Cおよび C++用終了処理プログラムのセクション

.rodata 初期値あり読み出し専用データのセクション

.data 初期値あり読み書きデータのセクション

.ctors C++用グローバルコンストラクタテーブルのセクション

.dtors C++用グローバルデストラクタテーブルのセクション

.sdata 初期値あり small data areaデータのセクション

.textセクションの転送処理の例を以下に示します。
� �

; copy .text section to RAM

seth r2, #high(__rom_text)

or3 r2, r2, #low(__rom_text) ; r2: src address

seth r3, #high(__text_start)

or3 r3, r3, #low(__text_start) ; r3: dest address

beq r2, r3, .Lendloop_text

seth r4, #high(__text_end)

or3 r4, r4, #low(__text_end) ; r4: end of text + 1

sub r4, r3 ; r4: text size(bytes)

blez r4, .Lendloop_text ; if size <= 0 break

.Lloop_text:

ldb r1, 2

stb r1, 3

addi r2, #1

addi r3, #1

addi r4, #-1

bgtz r4, .Lloop_text

.Lendloop_text:

 	

ただし、転送のために参照しているグローバルシンボルは、サンプルのリンカスクリプ
ト内で定義されたシンボルを使用しています。従って、この処理はリンカスクリプトの
定義と整合をとる必要があります。

� main関数へ引数 argvの設定
main関数への引数 argvの値として 0を設定しています。

� main関数または_c_main関数の呼び出し
三菱製 ANSI C標準ライブラリを使用する場合、_c_main関数 (標準ライブラリの初期化
関数)を呼び出します。_c_main関数を呼び出した場合、main関数は、_c_main関数内か
ら呼び出されます。
標準ライブラリを使用しない場合、main関数を直接呼び出します。
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� exit関数の呼び出し
exit関数を呼び出しプログラムを終了します。

4.5 スタートアッププログラムのマクロ定義

サンプルのスタートアッププログラムでは、次のマクロを用意しています。

TEXT_IN_RAM

プログラムコードの実行時アドレスとロードアドレスが異なる場合、このマクロ
を定義します。
このマクロが定義されている場合、プログラムコードをロードアドレスから実行
時アドレスへ転送後、main関数 (あるいは_c_main関数)を絶対アドレスで呼び出
します。
定義されていない場合、プログラムコードは転送されません。また、main関数
(あるいは_c_main関数)を相対アドレスで呼び出します。

NOUSE_LIB

三菱標準ライブラリを使用しない場合、このマクロを定義します。
このマクロが定義されている場合、直接 main関数が呼び出されます。定義され
ていない場合、標準ライブラリの初期化関数_c_main関数が呼び出されます。

USE_RESET_VECTOR

リセットベクタのコードを使用する場合、このマクロを定義します。デフォルト
ではリセットベクタを使用するように、このマクロは有効になっています。

4.6 スタートアッププログラムでのデータ領域の確保

サンプルのスタートアッププログラム内では、以下のデータ領域を確保します。

割り込みスタック領域
割り込みスタック領域を確保します。
必要な割り込みスタックのサイズを spi stack sizeシンボル値にバイトで定義し
ます。スタックサイズ値には 4の整数倍を指定してください。デフォルトでは、
8Kバイトを確保しています。
� �

.section .spi_stack, "aw", @nobits

.set spi stack size, 0x2000 /* 8Kbytes */

.balign 4

.space spi_stack_size

 	

ユーザースタック領域
ユーザースタック領域を確保します。
必要なユーザースタックのサイズを spu stack sizeシンボル値にバイトで定義し
ます。スタックサイズ値には 4の整数倍を指定してください。デフォルトでは、
8Kバイトを確保しています。
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� �

.section .spu_stack, "aw", @nobits

.set spu stack size, 0x2000 /* 8Kbytes */

.balign 4

.space spu_stack_size


 	

ヒープ領域
三菱製 ANSI C標準ライブラリで使用するヒープ領域を確保します。
必要なヒープ領域のサイズを heap sizeシンボル値に定義します。ヒープサイズ
値には 4の整数倍を指定してください。また、必要なヒープサイズは、ユーザー
プログラムで入出力関数 (printfなど)使用時にバッファを使用するかどうか (バッ
ファリングモード時)、メモリ操作関数を使用するかどうかに依存します。
入出力関数でバッファを使用する場合、1つの FILE構造体につき 1036バイト使
用します。したがって、使用する FILE構造体数 (ユーザープログラムで同時オー
プンするファイルの最大数 + 標準入力 + 標準出力 + 標準エラー出力)× 1036バ
イト以上が必要になります。デフォルトでは、100Kバイトを確保しています。

� �

.section .heap, "aw", @nobits

.set heap size, 0x19000 /* 100Kbytes */

.balign 4

.space heap_size

 	

main関数への引数 argv
main関数への引数 argvを設定します。デフォルトでは、argvとして 0を設定し
ています。　　
� �

environ:

.long 0
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